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CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR SALE 
OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES. 

 

OVERVIEW 
The SmartSpark LS is a versatile ignition 

module for GM LS1/LS6 and LS2/LS7 race engines. It 

is an upgrade for the MSD
® 

P/N 6010 and 6012 
ignitions. 

 
 Ignition module for carbureted GM LS series V8 

engines with 24 or 58 tooth crank trigger. 

 Selection for GM LS1 or higher energy LS2 style 
coils. 

 Preprogrammed with advance tables suitable for a 
wide range of normally aspirated high performance 
engines. 

 Digitally set launch, burnout, and maximum RPM 
limits with 100 RPM steps from 3,000 to 9,900 RPM. 
Access to launch and burnout RPM limits requires 
optional USB interface and PC Link software. 

 USB interface and PC Link software allows 
programming a custom 3D advance table based on 
RPM and manifold pressure 

 Individual cylinder timing (ICT) capability with RPM 
based offset up to ±5° with 0.1° steps. 

 Three general purpose input terminals. Inputs can be 
used for RPM limits and multiple retard functions 
including driver adjustable retard (requires optional 
RTD-1). Advanced features require optional USB 
interface and PC Link software. 

 Status LEDs show trigger inputs. 

 Fully encapsulated construction without any internal 
voids. 

 Heavy duty 12 pin Deutsch connectors used for 
signal connections. 

 Same mounting pattern as MSD
® 

P/N 6010 and 
6012. Compact size: 6.0”L x 3.5”W x 0.63”H. 

ADDITIONAL REQUIRED PARTS 
New LS1/LS6 installations require wire harness 

P/N 119002 or 119003 depending on mounting 
location. New LS2/LS7 installations require wire 
harness P/N 119005 or 119006 depending on 

mounting location.For upgrading existing MSD
® 

P/N 
6010 or 6012 installations, use adapter harness P/N 
119004. 

Use of the SmartSpark software is not required 
for basic operation of the module. The SmartSpark 
connects to your PC by means of an optional USB 
interface, P/N 102004. If you have an older PC without 
USB capability, you cannot use the software. 

For a driver adjustable timing retard, you will 
require the optional RTD-1 retard control P/N 102005. 

Figure 1 – SmartSpark LS Module 
 

 
 
 

Figure 2 – RTD-1 Retard Control 

Daytona Sensors LLC 
Engine Controls and Instrumentation Systems 

Installation Instructions for 
SmartSpark LS Ignition 

http://www.daytona-sensors.com/


Daytona Sensors LLC, 240 Springview Commerce Dr Bld 1-J Debary, FL 32713 
(386) 322-7390  www.daytona-sensors.com 

Page 2 

SmartSpark LS 
8/2021 

 

 

WIRING OVERVIEW 
 

Black 12 Pin Deutsch Connector Signals 

Pin Number Signal Description 

1 Coil Drive 1 Coil 1 drive signal 

2 Coil Drive 2 Coil 2 drive signal 

3 Coil Drive 3 Coil 3 drive signal 

4 Coil Drive 4 Coil 4 drive signal 

5 Coil Drive 5 Coil 5 drive signal 

6 +12V Power Switched +12V power 

7 Ground Connects to engine or chassis ground 

8 Coil Drive 6 Coil 6 drive signal 

9 Coil Drive 7 Coil 7 drive signal 

10 Coil Drive 8 Coil 8 drive signal 

11 Tach Connects to tachometer (standard 12V square wave signal) 

12 Not Used 
 

 
 

Gray 12 Pin Deutsch Connector Signals 

Pin Number Signal Description 

1 CKP Crankshaft position sensor signal input 

2 CMP Camshaft position sensor signal input 

3 Not Used 
 

4 MAP MAP sensor signal input 

5 Sensor Power +5V power for sensors 

6 MAP Ground MAP sensor ground 

7 Signal Ground Ground 

8 RS-232 TXD RS-232 transmit data (connects to USB interface) 

9 RS-232 RXD RS-232 receive data (connects to USB interface) 

10 GPI1 General purpose input 1 

11 GPI2 General purpose input 2 

12 GPI3 General purpose input 3 
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INSTALLATION 
1. Turn off the ignition switch and disconnect the 

battery ground cable before proceeding. 

2. If you are not upgrading an existing MSD
® 

P/N 
6010 or 6012 ignition module, skip ahead to step 
3. Remove the MSD

® 
module. The SmartSpark 

has the same mounting pattern as the MSD
® 

unit 
and mounts in the same location using the same 
hardware. For hookup, refer to the P/N 119004 
adapter harness diagram at the end of the 
instructions. Tape up any unused connections. 
Skip to step 4. 

3. Mount the SmartSpark module in a convenient 
location. For basic hookup, refer to Figure 3 and 
the appropriate wire harness diagram at the end of 
the instructions. Connect the ground terminal 
(black and black/white wires) to a suitable engine 
or chassis ground. Connect +12V power (pink 
wire) to the ignition switch. This circuit should be 
protected with a 20 amp ATC fuse. Connect the 
tach signal (white wire) as shown. Tape up any 
unused connections. 

4. Application specific signal connections. Refer 
to the following sections. 

5. MAP sensor. Do not operate the SmartSpark 
without a MAP sensor unless you have 
programmed an appropriate custom advance table 
and selected the MAP sensor disable option using 
the PC Link SmartSpark software. 

6. Initial switch settings: 

 Mode: 

0 for 24 tooth crank trigger and LS1 coils 

1 for 24 tooth crank trigger and LS2 coils 

2 for 58 tooth crank trigger and LS2 coils 

 Advance: 5 (conservative starting point for 
tuning most engines with 20º advance at 
3,000 RPM). Higher values result in more 
advance. 

 RPM Limit: set a safe RPM limit for your 
engine. The RPM limit is X100 switch 
setting (i.e. 67 = 6,700 RPM) 

Module switch settings are only read on initial 
power up. If you change switch settings, you must 
cycle power off/on for the new settings to take 
effect. 

7. Completing the installation. Reconnect the battery. 
Start engine and check timing. 

 

GPI1-3 Options 
General purpose input (GPI) modes can be 
programmed by means of the PC Link SmartSpark 
software and are described in the software section 
starting on page 11. With the exception of the analog 
retard option using the RTD-1, GPI1-3 inputs are active 
when +12V is applied. 

For MSD
® 

upgrades using the MSD
® 

retard and two 
step connections, program GPI1 as digital retard and 
GPI2 as launch RPM limit. Refer to page 15 for details. 

 

Automatic Transmission RPM Limit 
Switch Hookup 
Figure 4 shows typical hookup of the line lock and 
trans brake solenoid valves for automatic transmission 
vehicles. 

1. Line lock and burnout RPM limit. Skip ahead if 
this feature is not used. The line lock is active 
during burnout and used to select the burnout 
RPM limit. GPI1 must be programmed for burnout 
RPM limit mode (refer to page 15 for details). 
Burnout RPM limit is selected when GPI1 is at 
+12V. 

2. Trans brake and launch RPM limit. The trans 
brake is active before launching and used to select 
the launch RPM limit. GPI2 must be programmed 
for launch RPM limit mode (refer to page 15 for 
details). Launch RPM limit is selected when GPI2 
is at +12V. 

 

 

Manual Transmission RPM Limit 
Switch Hookup 
Figure 5 shows typical hookup of the line lock and 
burnout RPM limit switch for manual transmission 
vehicles. 

1. Burnout RPM limit. Skip ahead if this feature is 
not used. A switch is used to select the burnout 
RPM limit. GPI1 must be programmed for burnout 
RPM limit mode (refer to page 15 for details) for 
details). Burnout RPM limit is selected when GPI12 
is at +12V 

WARNING: Failure to install the diodes 
shown in Figure 4 will damage the 

SmartSpark and void the warranty. 
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2. Line lock and launch RPM limit. The line lock is 
active before launching and used to select the 
launch RPM limit. The hookup shown in Figure 5 
uses a relay to hold the line lock on until the clutch 
is released. A normally open momentary 
pushbutton switch is used to initially set the line 
lock. The clutch switch is normally open and closes 
when the clutch pedal is down. GPI2 must be 
programmed for launch RPM limit mode (refer to 
page 15 for details).The launch RPM limit is 
selected when GPI2 is at +12V. 

 

 
 

 

RTD-1 Retard Control Hookup 
The RTD-1 retard control is required for 0-10° 

driver adjustable retard (GPI3 analog retard mode - 
refer to page 15 for details). 

The RTD-1 unit is not waterproof and is intended 
for under dash mounting only. Refer to Figure 6. 
Connections are made to the gray 12 terminal Deutsch 
connector (PL2) on the SmartSpark. Power and ground 
connections are spliced into the existing MAP sensor 
wires. Connect the RTD-1 black ground wire to  
terminal 6 and red +5V power wire to terminal 5. 
Connect the white retard command wire to GPI3 on 
terminal 12. 

WARNING: Failure to install the diode 
shown in Figure 5 will damage the 

SmartSpark and void the warranty. 
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Figure 3 – Basic Hookup 
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Figure 4 – Automatic Transmission RPM Limit Switch Hookup 
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ADVANCE SETTINGS 
The SmartSpark module accommodates a wide 

range of engine applications. The advance switch 
allows you to control the aggressiveness of the ignition 
advance. Figures 7-8 show the effect of advance 
switch settings. Each figure shows advance curves for 
various manifold pressure values. Higher switch 
settings result in more aggressive advance. The effect 
is more pronounced at high manifold pressures. Note 
that 30 In-Hg manifold pressure represents wide open 

throttle (WOT) and 16 In-Hg represents deceleration 
conditions. 

You can use the New Timing Table command in 
the PC Link SmartSpark software to visualize the effect 
of advance switch settings. Refer to the Creating A 
New Timing Table section starting on page 16 for 
details. 

 

Figure 7 – Chart Representing Advance Setting 0 (Least Aggressive) 
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Figure 8 – Chart Representing Advance Setting 9 (Most Aggressive) 
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SOFTWARE OVERVIEW 
Use of the software is optional and not required 

for basic operation of the SmartSpark module. If you 
are not planning on using the software, you can skip 
the rest of the material in this instruction manual. 

SmartSpark software runs under Microsoft 
Windows XP/Vista/7/8. PC Link SmartSpark software 
allows the user to program SmartSpark units with 
custom timing advance and individual cylinder timing 
(ICT) offset tables and to configure the function of the 
general purpose input (GPI) terminals and other engine 
parameters. SmartSpark Log software allows the user 
to view real time engine data during initial setup and 
dyno tuning. 

 

PC REQUIREMENTS 
The SmartSpark connects to your PC by means 

of a USB interface. The PC must have a free USB port. 
If you have an older PC without USB capability, you 
cannot use the software. 

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7/8. 
Data chart display is graphics intensive and a high 
speed Pentium processor is recommended. 
Processors slower than 300 MHz will exhibit sluggish 
program loading and response. 

PC Link SmartSpark software includes print 
commands to print parameters and timing tables. The 
program has been tested with Hewlett-Packard laser 
and inkjet printers and Epson inkjet printers. We 
recommend using a color inkjet printer. 

 

USB INSTALLATION 
If you have already installed the USB interface 

driver for the SmartSpark, you can skip this step. 

The USB interface for the SmartSpark is based 
on the FTDI FT232R chip and drivers that allow the 
unit to emulate a standard Windows RS-232 COM port. 
Updated Windows drivers, installation instructions and 
troubleshooting tips are available on the FTDI website 
at www.ftdichip.com. Additional information and 
troubleshooting tips can be found on the PC Link Tech 
FAQ on our website. 

A new USB driver that simplifies the installation 
process is available. This installs as an executable file, 
similar to other Windows programs. The Windows 
Found New Hardware Wizard will then detect the USB 
device when it is first connected and automatically 

install the correct driver without the user having to 
browse out. 

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's PC Link Tech FAQ for details. 

1. Make sure the USB interface is not connected to 
your PC. 

2. From the Website under Tech Center scroll down 
and click on the USB Driver link. When the File 
Download dialog box appears, click on "Run this 
program from its current location." Ignore any 
security warnings and click on Yes to continue. 

3. After installation of the driver is complete, connect 
the USB interface to the PC with the supplied USB 
cable. The Windows Found New Hardware Wizard 
will appear and complete installation of the USB 
driver. 

COM Port Configuration 

After completing the installation steps outlined 
above, you must configure the new COM port using 
Device Manager. 

1. Windows XP: click Start, Settings, Control Panel, 
System, Hardware, and then Device Manager. 
Windows Vista: click Start, Control Panel, System 
and Maintenance, and then Device Manager. 
Windows 7: Click Start, Control Panel, System 
and Security, and then Device Manager. For more 
information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new 
USB interface will as appear as USB Serial Port. 
Click on this new port. Click on the Port Settings 
tab. 

3. Click on Advanced. In most cases the wizard will 
have installed your new USB interface as COM5. 
Note the COM port number assigned for your 
system. For optimum performance, you should 
also change the BM Options Latency Timer to 2 
msec as shown in Figure 9. 

4. Once you have configured a COM port number for 
your new unit, make sure that you use this same 
COM port selection in the software by using the 
Port Setup command from the Communications 
menu. 
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Figure 9 – COM Port Configuration 
 

 
 

SOFTWARE INSTALLATION 
The software is supplied in the form of a 

compressed file downloaded from our website. The 
installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair. 

There are two programs to install: PC Link 
SmartSpark and SmartSpark Log. Start by installing PC 
Link SmartSpark. If you are downloading software from 
the web, only download and install one program          
at a time. Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's Tech FAQ for details. 

Use the Windows Explorer to launch the 
PC_Link_setup.exe file downloaded from our website. 
InstallShield will install the software in an appropriate 
folder under Program Files. 

Repeat the installation process for SmartSpark 
Log. Use the Windows Explorer to launch the 
SmartSpark_Log setup.exe file downloaded from our 
website. 
InstallShield will install the software in an appropriate 
folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link SmartSpark and SmartSpark Log 
will appear on the Windows Start Menu. You can then 

launch them just as you would any other Windows 
program. 

PC Link SmartSpark software requires the 
Monospace 821 BT fixed pitch printer font in order to 
properly align columns when printing. The Monospace 
821 BT font is included in the distribution media and 
automatically copied to your Windows Fonts folder 
during installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

 

PC LINK SMARTSPARK SOFTWARE 
PC Link SmartSpark software allows the user to 

program SmartSpark units with custom timing advance 
and individual cylinder timing (ICT) offset tables and to 
configure the function of the general purpose input 
(GPI) terminals and other engine parameters. The 
SmartSpark connects to your PC by means of a USB 
interface. A USB cable is supplied with the unit. The PC 
must have a free USB port. If you have an older PC 
without USB capability, you cannot use the unit. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the unit’s USB interface to use a 
different COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup. 

PC communications is possible when power is 
turned on and the engine has not yet been started. 
Note that no damage or data corruption occurs if the 
engine is inadvertently started while the USB interface 
is connected. 

After PC Link SmartSpark is launched, the main 
screen appears blank. You have two options for 
obtaining setup data for editing. You can open a 
previously saved or sample setup file by using the 
Open File command on the File menu. You can also 
download data from an attached SmartSpark unit by 
using the Download From EEPROM command on the 
Communications menu. 

Note that setup files use a .dat extension. You 
should create a separate folder to store these files. 

Once you have opened a setup file or 
downloaded data, you can use the Edit Timing Table 
and Edit ICT Offset (individual cylinder timing) 
commands from the Edit menu. You can edit the timing 
table data by clicking on and dragging individual points 
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on the chart display or you can directly edit numeric 
data on the spreadsheet grid. 

Once the appropriate parameters and timing 
table data have been entered, you can print the data 
using the Print Module Parameters and Print Timing 
Table commands on the Print Menu. You can save the 
edited setup file by using the Save File command on 
the File menu. 

You can upload the setup data to an attached 
SmartSpark unit by using the Upload to EEPROM 
command on the Communications menu. 

A setup file (SmartSpark_Sample.dat) is 
included in the program folder. 

 

DOWNLOADING DATA FROM 
EEPROM 

Connect the USB interface to the four terminal 
Deutsch connector on the wire harness (refer to Figure 
3). Set the switch on the USB interface to the "B" 
position. Turn on power to the SmartSpark. Do not 
start the engine. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 

correct COM port. The program will remember the new 
port setup. 

Download data by using the Download From 
EEPROM command on the Communications menu. 

If the download process is successful, the 
module parameters are displayed. You can then edit 
setup data as explained in subsequent sections. 

SmartSpark units are shipped from the factory 
with default parameters and timing tables loaded into 
EEPROM memory. If you have never uploaded any 
custom setup file to EEPROM memory, these defaults 
are what you will see. Defaults include switch selection 
of timing tables and all general options and general 
purpose inputs off or disabled. 

 

MODULE PARAMETERS 
Module parameters are displayed in a dialog box 

by using the Edit Module Parameters command on the 
Edit menu. Module parameters control the overall 
operation of the SmartSpark unit. 

Once you have opened a setup file or 
downloaded data, module parameters are displayed. 
Module parameters are saved along with the GPIO 
parameters and timing table data when you save a 
setup file. Always check the module parameters 
before uploading data to the SmartSpark. 

 

Figure 10 – Module Parameters 
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General Options 

Individual Cylinder Timing (ICT) - selecting this 
option enables individual cylinder timing. 

Automatic Start Retard - selecting this option 
enables the automatic start retard and the start retard 
slider is displayed. You can set a start retard value 
from zero to 10 degrees. The automatic start retard is 
active for 10 engine revolutions after engine start while 
the engine is running below 450 RPM. 

Fixed Maximum RPM Limit - selecting this option 
overrides the maximum RPM limit value set on the 
switches and the RPM limit slider is displayed. 
However a lower launch or burnout RPM limit can still 
be selected. 

Delay Comp - the slider allows fine tuning the timing to 
eliminate the effects of spark firing delay in the ignition 
coils. A typical value is 0.3 degrees. Check the timing 
with a timing light. If a noticeable retard is observed 
between 2,000 RPM and the upper RPM range of the 
engine, use a higher value for delay compensation. 

Timing Table Options 

Switch Selection - the unit will use the factory 
programmed minimum and maximum advances tables 
in permanent FLASH memory and interpolate between 
these two tables based on the advance switch setting. 
Refer to the page 9 for details. 

Custom Table - enables a 3D timing table with timing 
based on engine RPM and manifold absolute pressure 
(MAP). The MAP sensor option box appears. You can 
select disabled, 1 bar, 2 bar, or 3 bar MAP sensor. If a 
MAP sensor is not connected, select the disabled 
option. In this case the unit will use the lowest manifold 
pressure row (16 In-Hg) on the 3D timing table. 

 

GENERAL PURPOSE INPUT 
PARAMETERS 

General purpose input (GPI) parameters are 
displayed in a dialog box by using the Edit GPI 
Parameters command on the Edit menu. GPI 
parameters control the function of the GPI1, GPI2, and 
GPI3 inputs on the SmartSpark unit. 

GPI parameters are saved along with the 
module parameters and timing table data when you 
save a setup file. Always check the GPI parameters 
before uploading data to the SmartSpark. 

 

Figure 11 – GPI Parameters 
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General Purpose Input 1 (GPI1) 

GPI1 has three modes: 

Off - the GPI1 input is disabled. 

Burnout RPM Limit Input - the burnout RPM limit will 
be active and override any launch RPM limit setting or 
higher maximum RPM limit setting whenever a +12V 
signal is detected on GPI1 

Digital Retard - you can enter a retard value from zero 
to 20 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI1. 

General Purpose Input 2 (GPI2) 

GPI2 has two modes: 

Off - the GPI2 input is disabled. 

Launch RPM Limit Input - the launch RPM limit will be 
active and override any higher maximum RPM limit 
setting whenever a +12V signal is detected on GPI2 

Digital Retard - you can enter a retard value from zero 
to 20 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI2. 

General Purpose Input 3 (GPI3) 

GPI3 has three modes: 

Off - the GPI3 input is disabled 

Analog Retard - the optional RTD-1 retard control is 
connected to GPI3, the +5V sensor power supply, and 
signal ground on the SmartSpark. The RTD-1 can be 
used to dial in a zero to 10 degree retard. Zero volts on 
GPI3 corresponds to zero retard and +5V corresponds 
to 10 degrees retard. This mode can be used as a 
driver adjustable timing function. 

Digital Retard - you can enter a retard value from zero 
to 20 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI3. 
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CREATING A NEW TIMING TABLE 
Use the New Timing Table command on the Edit 

menu. A dialog box appears and allows you to enter 
the advance switch setting. Each time you click on 
Update, the corresponding timing table is displayed. 

You will find the New Timing Table command 
useful for generating a timing table that will serve as a 
starting point for further edits. When you are ready to 
proceed with editing, click on OK. After you have  
edited the table, you must use the Save Table Edits To 
Buffer command from the Edit menu to save your edits 
to buffer memory. If you use the Close Table command 
from the Edit menu, all your edits are lost. 

 

Figure 12 – New Timing Table 
 

 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link  
SmartSpark is intended to be an open system and 
uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link SmartSpark. 

Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit  
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command. 

Figure 13 – Modify Command 
 

 
 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link SmartSpark program. In the 
PC Link SmartSpark program, you can select a range 
of cells with the mouse and right click to bring up a 
copy and paste menu. When you paste data into the 
PC Link SmartSpark program, the data is automatically 
checked and any out-of-range data corrected. 
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EDITING TIMING TABLE DATA 
Once you have timing table data, you can edit 

the data by clicking on and dragging individual points 
on the chart display or you can directly edit numeric 
data on the spreadsheet grid. 

The 3D timing advance table consists of 21 
columns corresponding to 500 RPM increments from 
zero to 10,000 RPM and 8 manifold pressure (MAP) 
rows. The MAP range depends on the type of MAP 
sensor selected under module parameters. The timing 
value at 10,000 RPM is used at all higher RPM levels 
and the timing value in the lowest MAP row is used at 
all lower MAP levels. Note that 30 In-Hg corresponds 
to atmospheric pressure (zero boost). Normally 
aspirated engines will not exceed 30 In-Hg and not all 
supercharged engines will reach the maximum MAP 
level for 2 bar or 3 bar MAP sensors. 

The timing range of the SmartSpark is from zero 
to 45 degrees. The program will not allow you to enter 
values outside this range. 

After you have edited the table, you must use 
the Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost. 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link  
SmartSpark is intended to be an open system and 
uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link SmartSpark. 

Figure 14 – 3D Timing Table 
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Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit  
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu as shown in Figure 13. 
When you enter a value, the presence of optional sign 
(+ or -) or percent (%) characters affects the outcome 
of the Modify command. 

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link SmartSpark program. In the 
PC Link SmartSpark program, you can select a range 
of cells with the mouse and right click to bring up a 
copy and paste menu. When you paste data into the 
PC Link SmartSpark program, the data is automatically 
checked and any out-of-range data corrected. 
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EDITING ICT OFFSET TABLE DATA 

Once you have individual cylinder timing (ICT) 
offset table data, you can edit the data by clicking on 
and dragging individual points on the chart display or 
you can directly edit numeric data on the spreadsheet 
grid. 

The ICT offset table consists of 21 columns 
corresponding to 500 RPM increments from zero to 
10,000 RPM and 8 cylinder number rows. The timing 
value at 10,000 RPM is used at all higher RPM levels. 

The ICT offset timing range of the SmartSpark is 
from -5 to +5 degrees. The program will not allow you 
to enter values outside this range. 

After you have edited the table, you must use 
the Save Table Edits To Buffer command from the Edit 

menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost. 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link  
SmartSpark is intended to be an open system and 
uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link SmartSpark. 

 

Figure 15 – ICT Offset Table 
 

 
 
 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link 

 

SmartSpark is intended to be an open system and 
uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
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chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link SmartSpark. 

Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit  
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu as shown in Figure 13. 
When you enter a value, the presence of optional sign 
(+ or -) or percent (%) characters affects the outcome 
of the Modify command. 

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link SmartSpark program. In the 
PC Link SmartSpark program, you can select a range 
of cells with the mouse and right click to bring up a 
copy and paste menu. When you paste data into the 
PC Link SmartSpark program, the data is automatically 
checked and any out-of-range data corrected. 

 

UPLOADING DATA TO EEPROM 
Refer to the Downloading Data from EEPROM 

section on page 13 for details about USB interface 
hookup and COM port setup. Before uploading, make 
sure the parameters and timing tables are correct. 

Upload data by using the Upload To EEPROM 
command on the Communications menu. A status 
message is displayed when the upload process has 
been successfully completed. 
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SMARTSPARK LOG SOFTWARE 
When the engine is running, you can display real 

time engine data on an instrument panel type screen 
as shown in Figure 16 by using the View Real Time 
Data command on the View menu. 

Connect the USB interface. Set the switch on 
the USB interface to the "B" position. Turn on power to 
the SmartSpark. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup. 

Real time engine data is displayed on an 
instrument panel type layout with a round tach gauge 
and bar graph type gauges for all other parameters. 
Status messages are displayed in a separate window. 

If the engine is not running, most values will appear as 
zero or off. 

Displayed parameters include: 

MAP – manifold pressure in In-Hg (29.92 In-Hg 
corresponds to sea level atmospheric pressure). 
Not displayed if the MAP sensor disable option 
is selected under Module Parameters (refer to 
page 13) 

RPM – engine crankshaft RPM (numeric value 
displayed beneath gauge) 

ADV – ignition advance in degrees (for cylinder 
1 when ICT is active) 

GPI3A - GPI3 analog input voltage (0-5V) 

BAT – battery voltage 

GPI1-3 – red if the corresponding input is active 

 
 

 

Figure 16 – Real Time Engine Data Display 
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APPENDIX – RECOMMENDED 
PARTS AND SUPPLIERS 

 

MAP SENSORS 
Recommended MAP sensors are listed in the 

table below. Note that Wells is stocked by Autozone 
(www.autozone.com) and SMP (Standard Motor 
Products) is stocked by RockAuto 
(www.rockauto.com). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WIRE 

Wire supplied with most automotive accessories 
is usually un-tinned copper with a low number of 
strands. The unprotected copper in this inexpensive 
wire quickly oxidizes, especially when in contact with 
dissimilar metals on terminals. The low number of 
strands limits life in applications where flexing occurs. 
We recommend the use of high quality industrial grade 
wire with tinned copper strands and a high strand 
count. 

18-20 AWG sizes can be used for all signal and 
low current applications. 16-18 AWG is adequate for 
line lock and trans brake solenoid wiring. 14 AWG 
should be used for high current fuel and nitrous 
solenoid wiring. Carol UL grade 1007/1015 wire is 
available from Digi-Key. 

P/N Description 

C2040X-100 20 AWG wire (100 foot spool) 

C2064X-100 18 AWG wire (100 foot spool) 

C2104X-100 16 AWG wire (100 foot spool) 

C2105X-100 14 AWG wire (100 foot spool) 

Note: replace X with color code B=Black, 
W=White, R=Red, G=Green, A=Orange, 
Y=Yellow, L=Blue, N=Brown, S=Gray, 
V=Violet 

 

CRIMP TERMINALS 

High quality crimp terminals and a proper 
crimping tool are required to make reliable electrical 
connections. Crimp terminals commonly sold in 
automotive and hardware stores have brittle vinyl 
insulation that easily cracks. We recommend the use of 
high quality industrial grade nylon insulated crimp 
terminals. The following parts are available from Digi- 
Key. 

P/N Description 

A27241 16-20 AWG #10 ring tongue terminal 

A27246 16-20 AWG 1/4” ring tongue terminal 

A27248 16-20 AWG 3/8” ring tongue terminal 

A27262 14-16 AWG 1/4” ring tongue terminal 

A27264 14-16 AWG 3/8” ring tongue terminal 

A27288 10-12 AWG 1/4” ring tongue terminal 

A27291 10-12 AWG 3/8” ring tongue terminal 

A0911 18-22 AWG .110” female quick 

disconnect terminal 

MNU18-187DFIK 18-22 AWG .187” female quick 
disconnect terminal MNU18-

250DFIK 18-22 AWG 1/4” female quick 

disconnect terminal 

MNU14-250DFIK 14-16 AWG 1/4” female quick 
disconnect terminal 

A1069 16-22 AWG butt splice 

A1080 14-16 AWG butt splice 

A1086 10-12 AWG butt splice 
 

RELAYS 

The typical import brand 30-40 amp relays leave 
little safety margin. When used to switch heavy 
inductive solenoid loads, arcing can result in the 
contacts welding together – a potentially catastrophic 
failure mode. We recommend using Tyco/P&B 
automotive OE grade relays available from Newark 
Electronics and Digi-Key. Use the 40 amp version for 
most applications and the 70 amp version for 
fuel/nitrous solenoid activation. We recommend that 
you use the relay sockets and crimp terminals listed 
along with the relays. 

P/N Description 

1432791-1 40 amp VF4 series relay 

VCF4-1001 Socket for VF4 series relay 

Range Delphi P/N Aftermarket P/Ns 

1 bar 
(normally 

12219927, 
16254719, 

Daytona Sensors 
115011 

aspirated 16175339, Wells SU105 
engines) 12247561 

SMP AS165 

 

2 bar (0-15 
psi boost) 

 
 
16009886 

Daytona Sensors 
115012 

Wells SU129 

SMP AS4 

 

3 bar (0-30 
psi boost) 

 
 
12223861 

Daytona Sensors 
115013 

Wells SU504 

SMP AS210 
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60249-1 12-16 AWG terminal for VF4 

VF7-41F11 70 amp VF7 series relay 

VCF7-1000 Socket for VF7 series relay 

42281-1 14-18 AWG terminal for VF4 coil 
connections (2 required) 

 10-14 AWG terminal for VF7 
contact connections (2 required) 

 

FUSES AND FUSE TAPS 

ATC series fuses and fuse holders commonly 
used for automotive applications are only available in 
40 amp and lower ratings. For high current 
applications, we recommend the heavy duty 50 amp 
Littlefuse Maxi Fuse series available from Digi-Key. 

P/N Description 

F1085 Maxi fuse block 

F1038 50 amp Maxi fuse 
 

 

SWITCHES 

All switches used in performance applications 
should be sealed. Representative sealed toggle and 
rocker style switches available from Digi-Key are listed 
below. 

P/N Description 

480-2191 Honeywell SPDT toggle switch 

360-2278 NKK SPDT rocker switch 

RELIABLE CONNECTIONS TO EXISTING 
SIGNALS 

For some applications, you may have to tap into 
existing signal wires on the vehicle. We caution against 
using any of the so called “vampire clips” that make an 
insulation displacement connection. These have proven 
very unreliable in racing applications. They may      
even cause the original wire to fray and break. We 
suggest soldering any connections to existing signals. 
Use a stripping tool to cut through and push back  
about 1/4” of insulation at the spot on the original wire 
where you plan to make the connection. Wrap several 
turns of the new wire around, solder, insulate with self 
vulcanizing electrical tape, and use two cable ties to 
secure the splice as shown. Regular electrical tape will 
tend to unravel. Self vulcanizing electrical tape is 
available from Digi-Key as their P/N W213. 

 

 
 

SUPPLIERS 

Suppliers referenced in the Appendix are listed 
in the table below. Additional suppliers for connectors, 
electronic tools, mechanical hardware, and test 
equipment are listed on our website at 
www.daytona-sensors.com/tech_tools.htm. 

 

Supplier Phone Website 

Digi-Key 1-800-344-4539 www.digi-key.com 

Mouser 1-800-346-6873 www.mouser.com 

Newark 1-800-463-9275 www.newarkinone.com 

State Wire 
& Terminal 

1-800-922-6527 www.statewire.com 

http://www.daytona-sensors.com/
http://www.daytona-sensors.com/tech_tools.htm
http://www.digi-key.com/
http://www.mouser.com/
http://www.newarkinone.com/
http://www.statewire.com/
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Rs-232 
TERM COLOR SIGNAL 
1 WHT RS-232  RXD 
2 BU< RS-232 GN> 
3 WHT RS-232  TXD 

4   114017 SEAL 1 
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3 
4 
5 
8 
7 
8 
9 
10 
11 
12 

ORG/V'EL CKP 

 

TO SMARTSPARK 

g 5 6 c3 6 

 

 
PINK +12V PIR 

 

 

 

 

CMP 

9 'ii 'f ,'HU 

DEUTSCH EILK 
TERM COLOR SIGNAL 

1 YIO COILDRVl 
2 RED/II-IT   COLIDRV2 
3 EILU COILDRV3 
4 GRN/M-IT  COILDRV4 
5 GRN COILDRV5 
6 PIN< +12Y PIR 
7 EILK/M-IT  GNl 
8 ELU/M-IT  COILDRVB 
9 RED COILDRV7 
10 YIO/M-IT   COILDRV8 
11 vtlT TACH 
12 114017 SEAL 

  TO SMARTSPARK   

8 8 A & o 

9 'il 'il 1 H 1    
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========: IHT : TACH TERY 
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COLOR 
ORC 
BRN 
BRN 
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COILS 
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2468 
COLOR 

TO USB INTERFACE 
A BLK 

8 RED/llHT 
C GRN/IHT 
E BRN 
F BLU/IHT 
G VIO/IHT 
H PIN< 

 

 

 
 

YEltBLU  RETARD 
81 

TWO STEP 

SMARTSPARK LS2/7 REMOTE MOUNT WI RE HARNESS 
P/N  119005 

DEUTSCH GRAY 
TERM COLOR SIGNAL 

BRN/IHT Clilfl 
114017 SEAL 
GRN/GRY MAP 
ORG +sV PV!fi 
BRN SENSOR GND 
BU< Rs-232 GND 
IHT Rs-232 TXD 
IHT Rs-232 RXD 
YEL/SLU RETARD/GPI 1 
BLU/ORG  TWO STEP/GPI2 
114017 SEAL 

COILS 1357 
TERM COLOR 
A BLK 
8 RED 
C GRN 
E BRN 
F BLU 
G VJO 
H PIN< 
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COLOR 
ORG/VELI 
BRN 
ORG 



 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

PINK +12V PIR 
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TERM COLOR 

 

 

 
 

 
 

COILS 1357 
TERN COLOR 
A ELK 
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TO SMARTSPARK 

8 6 6 6 6    

 9 'i 'i 1  1  1   

E BRN 
F ELU 
G YID 
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COILS 2488 
TERN COLOR 
A ILK 
B RED/•lff 
C GRN/VfiT 
E BRN 
F BLU/VfiT 
G YIO/M-IT 
H PIN< 
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TO SMARTSPARK 

8 8 & 0    

 

 
CKP 

A ORG/YELI 
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RS-232 
TERM COLOR SIGNAL 
1 WHT RS-232 RXD 
2 BU< RS-232  GNJ 
3 WHT RS-232 TXD 
4   114017 SEAL 

Im 
lti:LJ 

TO USB INTERFACE 

 

 

 

 

 

SMARTSPARK 
P/N  119006 

C
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LS2/7 MANIFOLD MOUNT WI RE HARNESS 

•TE•R•N 

CNP 
TERN COLOR 
A ORG 
B BRN 
C BRN 

DEUTSCH BU< 
TERM COLOR SIGNAL 

1 YID COILDRV1 
2 RED/M-IT  COLIDRV2 
3 BLU COILDRV3 
4 GRN/M-IT    COILDRV4 
5 GRN COILDRV5 
8 PIN< +12Y PIR 
7 BLK/VfiT  GNJ 
8 BLU/M-IT COILDRV8 
9 RED COILDRV7 
10 YIO/M-IT  COILDRV8 
11 Vl1-IT TACH 
12 114017 SEAL 

COLOR 
BRN 
GRN/GR 
ORO 

DEUTSCH GRAY 
TERN COLOR SIGNAL 

1 
2 
3 
4 
5 
8 
7 
8 
9 
10 
11 
12 

BRN/IHT Clilfl 
114017 SEAL 
GRN/GRY MAP 
ORC +5V PYlft 
BRN SENSOR GND 
BU< RS-232 GND 
IHT Rs-232 TXD 
IHT RS-232 RXD 
YEL/EILU RETARD/GPI1 
BLU/ORC  TWO STEP/GPI2 
114017  SEAL 

ORC/YEL  CKP 


